
Digital Technology Workshop 2:
Information Technology for Applied Mathematics:

2022/2023
Booklet

Use of Spreadsheets to generate, capture, analyse and export
data to the Applied Maths Modelling Report Booklet.



© PDST 2022

This work is made available under the terms of the creative Commons Attribution Share Alike 3.0 License

http://creativecommons.org/licences/by-sa/3.0/ie/. You may use and re-use this material (not including

images and logos) free of charge in any format or medium, under the terms of the Creative Commons

Attribution Share Alike Licence. Please cite as: PDST Applied Mathematics National Digital Technology

Workshop 2 2022

http://creativecommons.org/licences/by-sa/3.0/ie/


CONTENTS Page

Activity 1   Absolute and Relative Cell References 2
Activity 2   Generating a set of input and output values for a function                        12
Activity 3   Basic data analysis 17
Activity 4   Optimisation using a spreadsheet 20
Activity 5   Example calculation 21
Activity 6   Gravity ‘Battery’ calculation 22
Activity 7   Gravity ‘Battery’ spreadsheet 23

Appendices

Appendix 1   Working with images in Word and Google Documents 24
Appendix 2   A spreadsheet crash course to do in your own time 29
Appendix 3   Formulas 35
Appendix 4   The Control Toolbox 36
Appendix 5   Free Spreadsheet software 38
Appendix 6   Additional files 39
Appendix 7   Signs, Symbols and Units 40
Additional Notes: 43

1



Activity 1: Absolute and Relative Cell references and Formulae
Input

Open the file called “Example 1G times tables” on the shared drive or USB. It should look

like the screenshot below.

Open a new spreadsheet. In Google Sheets or Microsoft Excel. Cells (blocks in the grid) are

referenced by column and then row. This can be counter intuitive at first. Click into Cell B7

as shown below.
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Double click Cell B7 to make it active in order to type or enter data into it. Type the number 1

into Cell B7 and then type =B7+1 into Cell B8 as shown below.

Now click outside of Cell B7 and notice that the

number 2 appears in Cell B8. Cell B8 should also

have a blue outline around it with a square in the

bottom right hand corner. This square is called the Fill

Handle and is shown on the right.

Click the fill handle highlighted in the image on the

right and holding your mouse or touchpad button down

drag this fill handle down as far as Cell B18 as shown

next.
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Note that the spreadsheet used relative cell references here. When you dragged the fill

handle down, the formula (=B7+1) you entered in cell B8 was modified automatically to

make it relative to the cell above, ie: the formula was modified by the spreadsheet in Cell B9

to read =B8+1 and in cell B10 to read =B9+1 etc, all the way down as far as you dragged

the fill handle. (Dragging the fill handle laterally will also work)

This is useful in this particular case as it gave us a quick way of incrementing numbers

without having to type in numbers into each cell manually. It can however be used to create

data sets for much more complex formulae.

Now to recreate our 6 times tables click into cell

C7 and type =B7*6. Hit enter on your keyboard

or click outside of cell C7 and observe.

If you again click on the fill handle and drag it

down as far as Cell C18 you will notice you have

created the 6 times tables and hopefully

understood a very useful feature of most

spreadsheets
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Another type of cell reference that is fundamental to getting the most out of your use of

spreadsheets in the Applied Maths classroom is an Absolute Cell Reference. We will take a

look at these now. Click into cell F7 and enter the number 1. Click into cell F8 and enter the

formula =F7+1.

We will then use the fill handle and drag this formula as far as cell F18 to increment our

values using relative cell references as before. Now for the interesting bit!

Type the number 8 in cell F5 and just to make the cell stand out you can also add colour or

highlight it using the fill colour icon shown below.

Then click into cell G7 and type the following formula =F7*F$5. This formula is now

instructing that cell to multiply the contents of cell F7 by the contents of cell F5. However, the

addition of the Dollar Symbol $ also instructs that cell to only ever reference cell F5. It

creates an absolute reference to a cell that won’t change. (This has immediately obvious

uses if say you want to make one cell a variable in the formula and have another formula

always refer back to a particular cell for a value for that variable which you can then change

independent of the calculation etc)

As you can see in the next screenshot, this is another potentially more useful way

(particularly in the context of Applied Mathematics) to achieve the same result as the

previous mini activity with the 6 times tables.
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Unfortunately, common spreadsheets like Google Sheets or Excel do not use all the exact

symbols we are familiar with, to

represent mathematical operations. For

example, instead of using a

multiplication symbol x, they use the

asterisk * symbol instead. A list of

common operators and their

spreadsheet equivalent is included in

our example spreadsheet and in the

image to the right.

You may not like the look of the 8 times tables we have created but if you wish to include the

operation that has been carried out on cells F7 to F18 to get the answers in cells G7 to G18

then something of workaround is required due to the different symbols spreadsheets use to

perform mathematical operations.

Type the number 8 into cell J5. Type the number 1 into cell J7 and use relative cell

references to increment this down as far as the number 12 in cell J18. Now click into cell L7

and type the formula =J7*J$5 which contains an absolute reference to cell J5. Click the fill
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handle and drag this formula down as far as cell L18. You should have something like the

below.

Now go to cell K7 and type

the following formula =" ×
"&J$5&" = " This instructs

the spreadsheet to display x
8 = in cell K7. Now use the

fill handle to drag this

formula down as far as cell

K18 and your 8 times tables

should look a bit more

presentable!

You can edit the text, background fill colour and borders of the cell to change the

appearance of the cells to improve the appearance even more if you wish and match the

example we are working from.
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Now we will work with a more familiar

example. In cell O5 type in the following

s = ut +1/2 a t^2

It’s a lot easier to do this than start

inputting superscripts and subscripts etc.

We are just inputting this so it is clear

what formula we are using. Highlight cell

O5 as well to make it stand out for clarity.

Into cell P2 type in 20 and cell P3 type in

-10. In cell O2 type in U and in cell O3

type in A. You should have something

similar to the image on the right

We will be using an absolute reference to cell P2 which contains a value of 20 for our initial

velocity and cell P3 which contains a value of -10 for deceleration.

Now in cell O7 type in zero and in cell O8 type in 07+0.5, now click the fill handle on cell O8

and drag this formula down as far as cell O18. These will be our t values incremented in

steps of 0.5. Label them by typing a t in cell O6.

Now type an s in cell P6 and type the formula =P$2*O7+0.5*P$3*O7*O7 into cell P7. Can

you see how this is the correct way to input the formula s = ut +1/2 a t^2 into the

spreadsheet with absolute references to cell P2 and P3 and relative references to cell O7?

Now click the fill handle on cell P7 and drag it down as far as P18. You should see

something similar to the below in your spreadsheet.
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Now highlight cells O6 to P18 as shown

Then click on Insert in the top ribbon and click

chart as shown below

Your spreadsheet should now have a chart inserted in it and look like the next screenshot.
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There are a number of settings for the chart that can be edited in the Chart editor dialogue

box on the right. We will now take a screenshot of this chart and export it into the

Mathematical Modelling Reporting Booklet.

When you have completed this task, open up the “Modelling Project Reporting Booklet” by

double clicking on it in the shared drive or USB. The first page of the "Modelling Project

Reporting Booklet" should look like the screenshot below.

Click back into your now completed “Example 1G times tables” spreadsheet. The first and

one of the fastest ways to export data from a spreadsheet into the "Modelling Project

Reporting Booklet" is to simply take a screenshot of it and paste it into the "Modelling Project

Reporting Booklet".
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To do this on a Windows machine simply access the snipping tool by pressing the Windows
logo key + Shift + S.

This will bring up a crosshairs (rectangular

selection by default but there are others) Now

hold down the left mouse/trackpad button and

drag the crosshairs to select a data table within

your spreadsheet, when you are happy that the

table is highlighted release the left button and an

image of your selection will be saved to the

clipboard

(The clipboard is just a temporary location on the computer that stores cut or copied

images/other data) Now click into the word document and again press CTRL+V. An image of

your Data Table should appear in the word document. Remember you can include up to 20

images in the "Modelling Project Reporting Booklet".

On a Mac pressing Shift + Cmd +4 should do the same thing and on a Chromebook the

command is Shift + Ctrl + Show windows (the show windows button looks like a rectangle

with two vertical lines next to it)
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Activity 2: Generating a set of input and output values for a
function and creating a chart
Open the file called “Example 2G Quadratic equation” on the shared drive or USB. It should

look like the screenshot below.

Open a new spreadsheet, click cell B6

and type y = 2 x^2 − 3 x – 5 in this

cell. This is the quadratic function we

will use for this example but we are

typing it here just to identify what we

are plotting for anyone viewing the file.

Type an X and Y into cells B8 and C8

respectively, again this is merely to

identify the variables we are producing

sets of data for. Your spreadsheet

should look like the screenshot on the

right at this point.

Now type in -5 in cell B9 and directly

below this type in =B9+1 and then

grab the fill handle on cell B9 and drag

this formula down as far as cell B19.

You are using relative references here again to increment the X values. Type

=B9*B9*2-B9*3-5 into cell C9 and take a moment to compare this to the quadratic formula
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we are working with. You should be convinced this does represent y = 2x^2-3x-5. Now grab

the fill handle on cell C9 and drag this formula down as far as cell C19. Your spreadsheet

should look like the screenshot below.

At this point use the mouse to highlight cells B9 to C19 (Left click and drag on most

Windows computers). Then, with this block of cells still selected go to the top ribbon, click on

insert and select chart as before. The chart title will probably default to y vs x so you can

click on this title and type in y = 2 x^2 − 3 x – 5 so it resembles our example. Your

spreadsheet should resemble the screenshot below.

Now try this example with absolute cell references. In cell B24 type y = a x^2 +b x +c. As

before this is just a title to avoid confusion. In cells B25, B26 and B27 type in a=, b= and c=
respectively. In cells B29 and C29 type in x and y respectively. Type in a -7 in cell B30 and

then as before increment this x value by 1 using the formula =B30+1 inputted in cell B31 and

dragged to cell B40 using the fill handle. Your spreadsheet should look like the next

screenshot.
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Now enter =B30*B30*C$25 +B30*C$26 +C$27 into cell C30 and note the absolute cell

references that take the values in cells C25, C26 and C27 as the a, b and c respectively in

the general form of the quadratic a x^2 +b x +c. This means you can now enter any values

you want for a, b and c into cells C25, C26 and C27. Before you do however grab the fill

handle on cell C30 and drag this formula down to cell C40. Now enter 1, 5 and 3 in cells

C25, C26 and C27 if you want to match the appearance of our example. Your spreadsheet

should now look like the below screenshot.

Now highlight cells B30 to C40 and insert a chart as before. You can customise the

appearance of your chart by clicking Customise in the chart editor window and changing
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any of the options under chart style there. Feel free to experiment. In the screenshot below

the background colour has been changed to yellow.

When you have completed this task open up the "Modelling Project Reporting Booklet" again

by double clicking on it in the shared drive or USB.

In the Example 2G file highlight the table

of data shown on the right. To do this,

click on a cell in one corner of the table

you are working with and then hold down

the shift key and use the arrow keys to

highlight all of the table.

Then press CTRL+C, now click into the

"Modelling Project Reporting Booklet"

and press CTRL+V and the table should appear in the Reporting Booklet. This approach has

the advantage and indeed possible disadvantage that the Data Table is copied into your

word document as a table with every cell editable etc. It can be useful if you want to edit a

chart or data within a word document.

Now click on the chart to the right of the Data Table and follow the same steps.

Copy and paste buttons are also available from the top ribbon under the edit tab in both

Google Sheets and Google Docs as shown next.
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Copy and paste buttons are also available from the top ribbon under the home tab in both

Excel and Word as shown below

If you prefer just to have an image of your data in the report then the easiest way to achieve

this is to use the windows snipping tool as used in Activity 1 (or similar

screengrab/screenshot commands available on your machine).

Where might what we have covered to date in this Workshop be useful in the classroom?
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Activity 3: Basic Data Analysis
Open the file called “Example 3G Data Analysis Regression” on the shared drive or USB. It

should look like the screenshot below.

When you have opened “Example 3G Data Analysis Regression”, select cells D7 to E28 and

copy them using CTRL +C. Open a new spreadsheet and paste these cells into the same

location in your spreadsheet by clicking cell D7 and typing CTRL +V. Your spreadsheet

should look like the screenshot below.

Now with cells D7 to E28 still selected go to the top ribbon and click insert and then select

chart. Your spreadsheet should now look something like the next screenshot.
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If a scatter plot is not automatically selected then select this

from the chart type menu. Now in the Chart editor menu to the

right select Customise and Series as shown on the right.

In the series menu, scroll down, select Trend line and tick the

show R2 checkbox.

Your spreadsheet should now look like the below screenshot.
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There are a number of helpful formulas for dealing with data we will take a look at now. Type

=AVERAGE(D8:D28) in cell D31 and observe what this does. Type =MODE(D8:D28) in cell

D32. Type =CORREL(D8:D28,E8:E28) in cell D33. Type =SLOPE(E8:E28,D8:D28) in cell

D34 and finally type =INTERCEPT(E8:E28,D8:D28) in cell D35. (If a formula is showing in a

cell and not an answer, go to the top ribbon, click view and then click formula to remove the

check and just display the answer in the cell)

Using the steps in the previous activities export an image and an editable version of your

completed chart to the "Modelling Project Reporting Booklet".
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Activity 4: Optimisation using a spreadsheet
Open the file called”Example 4G Maximum volume of a rectangular box” on the shared drive

or USB. It should look like the screenshot below.

Examine the spreadsheet paying close attention to any formulas. Using the skills we have

practiced in the previous 3 activities, create a copy of cells B16 to C60 from scratch in a

blank spreadsheet (without simply copying and pasting) and then create a chart of this data.

What is this chart telling us?  Your facilitators will be happy to help if you need any

assistance. A spreadsheet can make light work of tasks like these.

Where might students use the skills developed in the previous activities to aid their
learning?
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Activity 5: Example Calculation

Hydroelectricity could be considered to be a ‘Gravity Battery’

A water level difference of 1 m is equivalent to

● a pressure difference of 10 kPa and

● an energy difference of 10 J kg-1 of water =

10,000 J m-3

Question: If the depth is 30 m and the flow is 300

m3 per second, what is the potential generating

capacity?

Guided Solution

For each metre of depth, each cubic metre of water brings with it 10,000 joules of energy.

If the depth is 30 metres then each cubic metre will bring 30×10,000 J

If the flow rate is 300 cubic metres per second then the energy transfer per second is:

= 300 × 30 ×10000 J/s
= 90,000,000 J/s
= 90 megawatts or 90 MW

Note that this is the approximate specification of Ireland’s first, and still largest, hydroelectric

generator at Ardnacrusha.(head of water: 28.5 – 33 m; flow rate: can exceed 300 m3/s)

https://en.wikipedia.org/wiki/Shannon_hydroelectric_scheme

http://www.esbhydro.ie/shannon/07-Total-Ardnacrusha-Flow.pdf
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Activity 6: Gravity Battery Calculation
Read the specification of the Edinburgh Gravity Battery Demonstrator below

“During 2021 we successfully constructed, commissioned, and operated a 250 kW,

grid-connected demonstration project using a 15 metre high rig at the Port of Leith,

Edinburgh.

The demonstrator uses two 25 tonne weights suspended by steel cables. In a series

of tests, we dropped the weights together to generate full power and verify our speed

of response.”

Using the box below, calculate 1. the stored energy in the Edinburgh Gravity Battery

Demonstrator and 2. How long it can maintain maximum power

See 250kW Edinburgh demonstrator

https://gravitricity.com/projects/
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Activity 7: Using the Gravity ‘Battery’ spreadsheet
Open the file called ”Gravity  battery 01 - Demonstrator G” on the shared drive or USB. It

should look like the screenshot below.

We will briefly use this spreadsheet to demonstrate how the idea of the Gravity ‘Battery’ has

been transferred into a spreadsheet after the problem itself has been translated into

Mathematics. We will then ask you to explore this spreadsheet, find out how the formulae

were inputted and recreate a version of the spreadsheet for yourself. You will then be asked

to generate a set of input and output values from this formula by changing a variable and

export an image of the data table and the chart to the "Modelling Project Reporting Booklet".

(It should just be a simple straight line graph as it is a linear formula) For some basics on

working with imported images in Word please take a look at appendix 1.

Reflection

Do the skills developed in this workshop present any opportunities to enhance students’
experience of studying Applied Maths?

In bringing your learning back to your classroom, what are the next steps for you and your
students?

What challenges exist in bringing your learning back to your classroom? How could these
be overcome?
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Appendix 1: Working with Images and data in Word or Google
Documents

Importing images in Word

You may need to insert pictures and images into the report that you have saved to your

computer or located on the internet. To do this click the Insert tab on the top ribbon and click

the Pictures button or Online Pictures. The insert picture dialog box will appear. Navigate to

the picture you wish to insert, click on it then click Insert.

It is a similar process in a Google Document. As you can see below clicking on Insert and

then hovering over the image menu brings up a number of options for importing images in a

Google Document.

Editing images within Word

When you have inserted an image into a Word document you may wish to edit the image.

We will now take a look at the basics of resizing, cropping and text wrapping.
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Click on an

image and then

click and drag

a Sizing handle.

The Sizing

handles are

located on each

corner of the

object, as well as

on the top,

bottom, left, and right borders.

Clicking and dragging on the sizing handles on any corner will scale your image

proportionally. The top, bottom, left and right sizing handles will not resize your image

proportionally. The sizing handles shown above are those on the latest version of Google

Document but the process is the same in Word.

In Word, once you have clicked on the image to make it active, you can also enter

dimensions manually in the size group in the format tab in the top ribbon as shown below.

In Google documents this is a slightly more

involved process.

You must first click on the image, then click

on the Format dropdown menu.

Now click on Image options as shown on the

right.
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At that point an image options menu appears to the right of the document and you can select

the size and rotation dropdown if you wish to manually enter dimensions

If you need to Crop or cut a section of your image you can do this in Word by first clicking on

the image and then clicking the format tab.

Now click the crop button and

select “Crop to Shape” from the

dropdown and select rectangle from

the subsequent sub menu.

You may have to click crop again

after selecting rectangle on some

machines to get the crop handles to

appear on your image

The Crop handles work in a similar

fashion to the resizing handles only

this time they cut away sections of your image.

Crop can also be accessed via right clicking on your image if you have used if previously on

that computer

If you are editing in a Google Document Crop can be accessed by clicking on the image and

then clicking on the crop icon as shown below.
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One final thing that may be of use to

you when working with images in the

report is the symbol shown in the

image on the right.

This symbol should appear to the top

right of your image when you insert it

into a word document.

If you click this and it will bring up

the Layout options menu. There are

a number of options in this menu

that specify if an image is to be in

front of or behind text or if  text is to

be wrapped around it etc.

If you are unfamiliar with this it can

be a source of frustration when you

try to drag an image around a

document and instead of moving it snaps back to its original position etc)

Try these text wrapping options yourself to get an idea how text interacts with pictures with

each one. You can also find the Wrap text button in the arrange group in the format tab in the

top ribbon as shown below.
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If you are using Google Documents the text wrapping options will be visible as a menu below

an image when you click on it. An example is shown below.

One final tip that might prove useful! If you press Ctrl +Z (the Z letter key while holding down

the control key) this will undo your previous action. This can be useful if you accidentally

deleted an image or piece of text and want it restored. The keyboard shortcut to redo an

action is Ctrl +Y. A student once asked me “just how many undos can you do?”, the answer

here is it depends on settings in your preferences. Most computers will default to at least 20

actions that can be undone. If you select more it will require more memory set aside on your

computer.

28



Appendix 2: Spreadsheet exercises to try on your own time
If you would like to become more familiar with Excel or indeed Google Sheets (everything

that follows is applicable to both) a series of tasks are laid out below which should help.

A spreadsheet such as

Excel is an ideal tool for

processing tables of

numbers or text. It can

also be used to generate

graphs in a variety of

formats.

Start Excel by

double-clicking its icon.

This gives a blank

spreadsheet – a table of cells arranged in rows and columns. The rows are numbered but

the columns are labelled with the letters A, B, C etc.

Each cell therefore has a cell reference – e.g. A1, C1, F3. The convention then is column first

then row.

Task 1

On a new

spreadsheet

enter the

following data:

Adjust the widths

of the columns if

necessary; this is

done by dragging

the right-hand edge of a column heading.

Align the entries as above using the appropriate buttons in the alignment group in the home

tab on the top ribbon as shown below.
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Now we will calculate each student’s total mark. Select cell G4 and type =sum(D4:F4) and

press return. Note that this starts with an equal sign; this tells the spreadsheet to treat the

entry as a formula and not just a bit of text. Use the Fill handle on cell G4 to copy the formula

into cells G5 to G8; just click on the bottom right-hand corner of cell G4 and drag to cell G8.

Inspect cells G4 to G8 and note that the formula in each one is slightly different from the

others; Excel adjusted them automatically.

Similarly we can find the average mark in each subject. In cell D10 enter =average(D4:D8)

and press return. Drag the Fill handle of cell D10 to cell F10. Again the formulas are adjusted

automatically so that the average mark in each subject is correctly evaluated. Note that if any

mark is now changed the corresponding total and average will change as well. Try it and see.

Task 2

Handling longer lists

Open the spreadsheet called List1. It is a table of marks for over 100 students.

Note that the active window is split; this is useful when working with long lists.

Each part of the window then has its own right-hand scroll bar. The position of

the split can be adjusted by dragging the Split Bar; if it is dragged upwards as

far as it will go it becomes a little line at the top of the right-hand scroll bar. Try

it out; when you are finished restore it to the format shown above. (The

window can be split horizontally also.)
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In cell G4 enter the formula shown above. Then click cell G4; hold the Shift key and click cell

G135. Press Ctrl-d. This will copy the formula into the selected cells. (Using the Fill handle is

a bit awkward when using long lists.)

While the cells are still selected, right click and go to Format, Cells, Number, Decimal places,

and enter zero instead of the default value (2). Tip: For a quick way to start this press Ctrl-1.

Adjust the widths of the columns to suit the data.

Task 3

Sorting on single or multiple keys.

Selected blocks can be sorted using the Sort option in the Data menu. To sort the students

alphabetically select rows 4 to 135. This is easier to do while the screen is split; click the

heading of row 4, hold the shift key and then click the heading on row 135. Go to Data, Sort,

Column C (smallest to largest), then by Column B (largest to smallest), and press OK.

Try sorting by different keys – e.g. by surname  then first name, by  subject marks or total

marks. On other versions of excel this might be labelled ascending or descending. On

Google Sheets it is in the Data menu.

Be warned: If you sort the names only, they will become separated from the corresponding

data. Make sure you select all the data which is to be sorted.

Try some other sorts:

● Sort by average mark, in ascending order

● Sort by average mark in descending order

Task 4

Adding some colour

Right click on any cell to bring up

the menu shown (or click on the

home tab in the top ribbon) .
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Colour some columns or blocks; light shades work well especially if you intend printing your

spreadsheet.

Task 5

A different bar-graph

It is sometimes desirable to display numerical data graphically without using Excel charts.

Here’s an easy way to do it; it makes use of the REPT function. In cell H4 type the following:

=rept(“B”,7) and press return. Notice that it repeats the letter B seven times.

Select H4 again. This time enter =rept(“|”,g4). Can you see what it is doing? Copy this

formula into cells H5 to H135; the easy way is to fill down from H4 TO H135.

If the bars are too long for comfort, it is easy to change them. Select H4; go to the formula

bar and edit the contents to read  =rept(“|”,g4/2). Copy this down. This will make the bars

half as long. (Tip: For an alternative way to edit the current cell, press F2.).

You might try other variations on this such as using ‘Wingdings’ in column H.

The REPT function is available in Google Sheets too and can be an excellent way of

visualizing data when you get familiar with its use. It can make light work of spotting patterns

in what can seem like extremely large impenetrable data sets.
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Task 6

Relative cell references

Open a new spreadsheet and enter the data as shown below. Note that cell B6 contains a

formula : = sum(B2:B5)

To change the contents of a cell

simply select the cell with the

mouse or with the arrow keys, type

what you want to enter and press

the return key – or an arrow key.

Type some numbers in cells C2 to

C5. Now select B6 and press ctrl-C

(to copy its contents). Select cell C6

and type ctrl-v (to paste what you last copied). The spreadsheet automatically changes the

formula from “=SUM(B2:B5)” to “=SUM(C2:C5)”. In this case the spreadsheet program uses

what are called relative cell references – cells C2 to C5 are in the same positions relative to

C6 as cells B2 to B5 are relative to B6.

Task 7

Absolute cell references

Here is an example of the use of an absolute cell
reference (well, an absolute row reference to be

precise). Enter 1.27 into cell c1 and the formula

shown into cell c2 (=B2*C$1). This has a $ in front of

the 1; if this is copied into another cell the “1” part will

not be changed.

Try it. Drag the Fill handle of cell C2 as far as C6.

Examine what happens in each one; one part is

relative and the other is absolute.

The numbers can be changed to currency format as

follows: select a group of cells (c2 to c6); on the menu

bar select Format, Cells, Number, Currency, Symbol and select the euro symbol. (Note: If you

want a spreadsheet to do calculations with money then you must enter the quantities as

numbers only; do not type a currency symbol.)
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Task 8 (Extra)

Plotting a function

Clear the spreadsheet or start a new one. Enter the

three items shown: .1 in B1, =B3+B$1 in B4 and a

function such as =sin(b4) in cell C4, or any other

function you wish; the one used to generate the

graph shown below was =sin(b4)+sin(b4*3)/3. We

may regard the contents of cell B4 as our

independent variable, x, and the formula in C4 as the dependent variable – a function of x or

f(x). Click on cell B4; scroll to row 70, and while holding the Shift key click on cell C70. This

should select all the cells from B4 to C70. Now press ctrl-d; the x and y values will be filled in.

While the block is still selected go to the menu bar and select  Insert, Chart, XY-Scatter, click

the 4th option and click Finish. You should get a graph of the data. If the mouse pointer is

placed on items within the chart area a little label appears after a short delay; note the

terminology used  it is worthwhile familiarising yourself with terms such as Plot Area, Chart

Area, Series, Legend etc.

From the menu bar you can select Chart, Chart

Options… where you will find a number of properties

which you can play around with. If you activate the

Drawing Toolbar you should be able to change the

background colour etc.

If you want to experiment with the data change the

contents of B1 to 0.2; this value is the increment used in calculating the values of x for the

graph.

Note that the spreadsheet uses radians rather than degrees in trigonometric functions.

By the way if you wanted to plot an algebraic function such as a quadratic or cubic expression

just type your function into cell C4 remembering to type B4 instead of x every time. For

example try =B4^2–5*B4+6 and then copy it down. (That’s  x2 – 5x + 6  to you and me.) To

shift the graph a bit, enter a starting value into cell B3 (there was nothing here before). Try –4.

The possibilities are endless.
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Appendix 3: Formulas

The facility to use formulas as cell entries is what makes spreadsheets so versatile. Formulas

are almost infinitely variable and may apply to single cells or to selections of cells. Here is a

small selection of the available functions:

=SUM(B15:B17) sums the contents of the specified part of a column

=SUM(B15:C17) sums the contents of the specified block

=COUNT(B19:B27) returns the number of cells in the given range which contain

numbers

=AVERAGE(B19:B27) returns the average of the numbers in the given range

=MAX(B19:B27) returns the maximum number in the given range

=MIN (B19:B27) returns the minimum number in the given range

=VAR(B19:B27) returns the variance of the numbers in the given range

=STDEV(B19:B27)) returns the standard deviation of the numbers in the given range

=IF(B26=7,3,5) returns a 3 if the contents of cell B26=7; otherwise it returns a 5

=RAND()*100 generates a random real number between 0 and 100, exclusive
=INT(RAND()*100) generates a random whole number between 0 and 99, inclusive

=INT(RAND()*100+1) generates a random whole number between 1 and 100, inclusive

=CHOOSE(2, “A”, “B”, “C”, “D”) returns  B in this case

Most common mathematical operators and functions are also allowed:

+, -, *, /, =, <, >, <=, >=, <>, SQRT, SIN, COS, TAN, ASIN, ACOS, ATAN,

LN, LOG, EXP, 10^, ABS (absolute value), INT (integer value) etc.
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Appendix 4: The Control Toolbox (Spin Buttons, Sliders etc)
As you explore the additional resources provided with this workshop you may come across

some Excel spreadsheets that have features called spin buttons and sliders included. These

increment and decrement values in the cells they are linked to and are in this context they are

very useful feature if you want to quickly change a variable multiple times to see how an

output changes (and in turn produce a set of data and plot this data on a linked chart etc)

Spin Buttons and a

Slider can be seen in

the screenshot to the

right.

This file is available

for you to have a look

at and experiment

with and is called

“Excel Example 5”

Instructions for accessing the control toolbox on the most recent version of Excel follow.

Open Excel, click on file and then options.
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In options menu click Customize Ribbon and then under main tabs click the Developer Tab

Now go back to Excel file and the Top Ribbon should have a Developer Tab visible

With the developer tab open/active, go to the control group, click insert and the form controls

should appear

A control toolbox is not available in Google Sheets but it is possible to create something

similar to a spin button or a slider by assigning a script to an image, however it is a little

awkward and if you want to implement something like this for a modelling project you are

probably better off working on spreadsheet program offline.
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Appendix 5: Libreoffice
If you do not have access to Microsoft Office and you prefer to work offline or would like to

access functions such as spin buttons a free software calle LibreOffice is available. The

spreadsheet program in LibreOffice is a very powerful piece of software capable of

everything we have covered in this workshop (and a whole lot more besides) Most of the

menus and steps are also quite similar and it's free to download so could be an excellent

option to consider.

https://www.libreoffice.org/discover/libreoffice/
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Appendix 6: Additional files

In addition to the files used

for the activities in this

workshop a number of

other files have been made

available that showcase

other possibilities.

These are by no means

exhaustive but do serve to

highlight some other

strands of the Applied

Maths Specification where

spreadsheets could

enhance teaching and

learning.

To pick just two as examples, the spreadsheet titled “Predator-prey populations” shows how

Difference Equations could be inputted and visualized and the spreadsheet titled “Orbit 03G”

which uses polar coordinates to create an animation of the Earth and Moon orbiting the Sun

could be useful for Circular Motion. Have a look through these and feel free to modify them

to suit your needs.
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Appendix 7: Signs, Symbols and Units
Applied Maths and Science are very precise languages and hence signs and symbols have

a definite meaning.

SI Units

SI units were introduced in 1960 to avoid international confusion of units.  'SI' stands for

'Système International d'Unités'.

There are seven base units:

Quantity Unit Symbol

Length metre m

Mass kilogram kg

Time second s

Electric current ampere A

Temperature difference kelvin K

Amount of substance mole mol

Luminous intensity candela cd

All other SI units are derived from these base units.

Careless use of signs and symbols can confuse students and lead to many learning

difficulties, e.g. using the symbol 's' for seconds sometimes and the incorrect 'sec' more

times.
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Basic Rules when typing SI units

1. The symbol for a unit is always Roman (upright) font and there is always one space

between number and unit and one space between unit and unit e.g. five metres would be

written as 5 m and two metres per second as 2 m s-1.

Note: No plurals, e.g. the symbol for metre and metres is m.

2. The symbol for a unit named after a person has a capital letter e.g. N. The name of the

unit, however, begins with a small letter, e.g. newton.

3. Multiples and sub-multiples of units are indicated by the standard prefixes, increasing

and decreasing by factors of 103. In general, sub-multiple symbols are lower case letters

and multiple symbols are upper case letters e.g. two millimetres is 2 mm and eight

megagrams is 8 Mg. ‘k’ for kilo is an exception

Note: The prefix and the unit make one word and there is no space between the

symbols.

4. The recommended method of showing division (⎟) of symbols is to use a negative index,

e.g. newton per metre squared is written N m-2.

Note: the solidus (/) is also permitted but not recommended.

5. Symbols for physical quantities i.e. quantities which can be measured, should always be

written in italics, e.g. mass is denoted by m. This avoids confusion with the metre symbol

m.  Symbols for vector quantities are printed in bold italics where it is wished to

emphasise the vector nature of the quantity.

6. Equations are relationships between physical quantities and should be written in italics,

e.g. v = u + at.

Note: no space between a and t in at above.

7. Superscripts and subscripts are usually not italics e.g. v2 = u2 + 2as or when used for

the displacements s1 and s2.

8.  Graphs are relationships between pure numbers and axes should be labelled accordingly.

Since a physical quantity consists of a number multiplied by a unit it follows that the

number is equal to the quantity divided by the unit, e.g. F = 5 N => 5 = F/N. Thus the

axes of a graph of force against acceleration should be labelled F/N and

a/m s-2. Columns of data in tables should be headed in the same manner.

Note: The symbol for a physical quantity, e.g. F for force, represents both the number

and the unit. It is therefore incorrect to write: force = F N .
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∙Scientific notation should be used.  In scientific notation numbers are always written

with one digit before the decimal. The number of digits after the decimal indicates the

accuracy, e.g. 8.0 ⋅ 103 indicates a value between 7950 and 8049.

∙Numbers with more than four digits have a space between groups of three digits,

counting from the decimal point, instead of a comma,

e.g. 24 567.001 23 [all on same line]. This is to avoid confusion with countries where

a decimal is denoted by a comma.

 9. Use proper '⋅' sign  for multiplication rather ' x'.
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Additional Notes
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